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The instructions in this article cover the various functions available in Certificates. The
icon may be located on your StrataMax Desktop or found using the StrataMax Search.

When a property is sold, the purchaser requires a certificate containing details of the property. These
could include levies, current insurance policies, and exclusive use areas.

StrataMax automatically selects the certificate which is appropriate for the building type based on the
state that the building resides in and its legislation. So for example, a Queensland building using the type
B.F.P., StrataMax will print a Body Corporate Information Certificate.

To create the certificate, StrataMax merges info from various areas within the system to produce a strata
certificate. The levy data for example is collected using the balance fields in levy invoice codes. It is
imperative that certain levy invoice codes are not changed since it will compromise the accuracy of the
certificate, as well as some StrataMax reports. More information can be found in Levy Invoice Code
Setup.

An optional cover letter may be printed automatically with a certificate.

Before printing a certificate, you should make sure that office bearers, asset register, and
insurance information is up to date, and that all receipts for the subject lot have been posted.

Documents such as copies of levy registers and the asset register report can be automatically printed
with each certificate, and the settings can be configured differently for each building. Documents with
specific information can also be automatically printed with each certificate if needed.

We also have the Certificates Video, which covers the Certificates process.

Certificates Configuration
This section covers the Configuration settings under the File menu.

http://smhelp.stratamax.com/help/levy-invoice-code-setup
http://smhelp.stratamax.com/help/office-bearers
http://smhelp.stratamax.com/help/asset-register
http://smhelp.stratamax.com/help/insurance
https://www.screencast.com/t/45k8HVwhu


Current Year Levies Only (User Setting) 
Only the levies that fall within the building's financial year will be displayed if set.

Minimum Asset Value (Global Setting) 
Any asset below the amount set in this field will not be displayed in the Asset Register on the certificate. 

Certs for Current Year Only (Global Setting) 
This sets the default for which template will be used when the Certificates menu is first opened.

Allow No Record of Emailed Certificate (Global Setting)  
If set, when the certificate is sent by email through StrataMax, it will prompt, 'Do you want to record this
certificate as being issued by email?' If No is selected, the certificate will not be recorded in 'Stored
Certificates'. This setting is not recommended.

Report Settings
Screen 
The certificate will display in screen-mode, allowing for it to be printed, emailed, saved as a PDF or
Saved to DocMax.

Printer 
Sends the certificate directly to the printer.

Template 
This certificate template will be automatically set based on the combination of state and type and
regulatory module for the building. 

Printer, Paper Source and Copies 
Select the printer and tray 'Paper Source' to which the certificate will be printed and the number of
copies to be printed.

Letterhead 
The default letterhead will be printed, or an alternative letterhead (if installed) will be available on the
cover letter for production.

Cover Letter (Ellipsis button) 

http://smhelp.stratamax.com/help/asset-register


Select from one of the available cover letter templates. The wording of the cover letter will be created
using the Edit Cover Letter button. 

Info Editor 
Some certificates have fields where more information can be added. This also will depend on the state
and certificate. Click on Info Editor and select the certificate from the drop-down list. The editable fields
will appear, and this information can be added for this building only or all buildings that use this
certificate type.

Document Inclusion 
Document Inclusion allows additional documents to be added to certificates from DocMax when they are
produced. Select which certificate type to add a document to from the drop-down list, then select to add
a document to the local building using Add Document (This Building Only) or to add a document to all
buildings that use the certificate type using Add Document (Global). This will open DocMax, which is
ready for the document to be added from this application or a network folder.

Applicant Tab
See also Certificate Applicants to add, edit or delete an applicant.

The Applicant tab is for inserting the details of the individual or organisation that has requested the
certificate. It is also where any applicable fees charged can be recorded. When used, this information
will merge into the cover letter.

Application Fee 
The amount charged for the certificate. 

Select Applicants 
Select the applicant for the certificate created from a list of stored applicants. 

Select Owner as Applicant  
Selects the owner as the applicant for the certificate being created. 

Save Changes to Applicant Details  
If an applicant is selected using the Select Applicant button, additional information can be added to the
Name and Address field and in the Reference field. This button allows the additional information to be
saved to that applicant's record. 

Set Sundry Applicants 
This is used to set up the initial Sundry Applicant. Once set (usually during the installation of StrataMax),
it will rarely be used to create a certificate.

Applicant Details
When creating a certificate, the applicant's details must be added. The Name and Address field will
populate the applicant's name and address details, and the Reference field can be used to enter the
applicant's reference.

There are three options available:

http://smhelp.stratamax.com/help/applicant-maintenance


The applicant's details can be entered manually using the Name and Address field, which is not

recommended.

Select Applicant from a list of applicants.

Select Owner as Applicant to select the Owner as the Applicant.

Application Fee
The fee for the certificate can be entered in this field when the certificate is generated and can be set as
the default, which will print on the cover letter if used and act as a tax invoice using the Paid or Not Paid
radio button. No transactions are created using this area, and the additional Disbursement area can be
set to create an automated charge for the administration of issuing a certificate where needed.  

To set the application fee as a default:

1. Search or select Certificates. 

2. Click the Applicant tab.

3. In the 'Application Fee Amount' field, enter the amount, then select the Paid or Not Paid radio

button.

4. Then click Set as default.

Sealing Clause Tab
The sealing clause is used in certificates to authorise the affixing of the common seal for the plan. As the
wording is slightly different for each state act, you can set a default sealing clause, including a blank
clause for states that may not require this to be included, which will be automatically used when
producing certificates for your state.

Creating or Editing a Sealing Clause
1. Search or select Certificates.

2. In the Sealing Clause tab, select the sealing clause most closely resembles the one you wish to use.

3. Edit the text of the selected sealing clause to contain the wording required in the new clause.

4. Click Save As, then click on Global (available in other buildings) or Local (available only in this

building).

5. Enter the name of the sealing clause, then click OK.

6. Highlight the sealing clause, then click Set as Default. Depending on whether Global or Local was

selected, this clause will be the default sealing clause. 

The wording used in the sealing clause can be customised to suit your requirements; if there is no
legislative requirement for any wording, a blank sealing clause can be saved and set as the default.
Merge fields can be used to merge information found in Building Information or Office Bearers. The
following legend shows the data that can be merged within the sealing clause. 

{BodyCorpManager} The name of the Body Corporate/Strata Manager from Office Bearers.

{Title} The Strata Plan Number or the name of the building.

https://smhelp.stratamax.com/help/disbursements-56#certificates


{Name} Name of the building.

{PlanType} Plan Type in Building Information

{CTSNumber} CTS Number field in Building Information.

{RegMod} Regulatory Module set in Building Information (If None, this will be left blank).

{FullPlanType&Number}Same as {Title} or the Plan Type and Number.

{PlanNumber} Plan Number field in Building Information.

{Date} Date in the format of DD Month YYYY (e.g. 23 April 2019).

Creating a blank Sealing Clause

The Sealing Clause wording can be adjusted to print blank. If multiple certificate types are used, each
should be reviewed and removed if needed.

1. Search or select Certificates.

2. From the Sealing Clause tab.

3. Select the text from the preview area in the right corner, right-click it, and Delete.

4. Click Save As, select Global for all buildings or Local for the local building option, and enter a

description for the blank wording.

Creating an Electronic Seal/Signature
The Common Seal and account manager's signature for a building can be scanned and added to
StrataMax certificates. When a certificate is produced, the seal and signature are automatically affixed
based. The seal and signature are first saved onto a Word document and can then be imported into
StrataMax. 



There is a per-user setting titled Print Seal and Signature, which must be ticked to produce the saved
Seal and Signature.

When the seal/signature is added to the Certificates menu, the document with the Common Seal and
signature is automatically saved in DocMax for that building. The title will be 'Certificate Seal', which
can be used in a Search to locate these documents. however, there will not be a category allocated,
but more details can be added to the document properties if required.

Scanning and editing the Common Seal/Signature

1. Scan the building's common seal and the account manager's signature, making sure they are

scanned in an image format. This should be .png or .jpg.

2. Now open the image in an image editor program like MS Paint, 3D Paint, Adobe Photoshop

Express., Abobe Illustrator, etc.

All the open space around the seal and signature needs to be removed.

The image size needs to be adjusted so that the height is no bigger than 130 pixels. 





3. Once the image has been cropped so all the white space around the seal and signature is removed,

and the height is no bigger than 130 pixels, save the image and then insert it into a Word document.

4. Save the Word document, and make a note of the folder that it's been saved in - this will be needed

in the next steps.

Adding an Electronic Seal to the Building

1. In Certificates, click the Sealing Claus tab.

2. Click the Seal/Sig Location button.

If this is a Multi OC building, an additional window will appear to select the required OC first.

A prompt asking to set one up will appear if no seal and signature currently exist. Click Yes. 

If a seal and signature have already been set up, clicking the Seal/Sig Location button will

open a new screen where the seal's positioning can be changed. However, the seal's

size must be changed in the Word document.

3. Navigate to the saved Word document with the scanned seal and signature, and click the

Open button. This will convert the Word document and automatically open the Report Template

Editor. 



 

4. To move the seal and signature, click on it first so the red box appears, then click on it again and

hold the mouse button before dragging it to the required position.

 All certificate templates across all states require the electronic seal be placed in the upper-

right corner of the template (the template then manages the actual placement during

processing and printing).

5. Close the Report Template Editor screen, and click Yes to save the changes.

6. Now, produce a certificate, but make sure the Screen radio button is selected to be previewed first

to check that the seal and signature are in the correct position.

Select any lot from the Lots tab and any applicant from the Applicant tab. Make sure the Print

Seal/Signature is ticked, then click Proceed.

7. Scroll down the preview screen to where the seal and signature are to ensure they're in the right

spot. If not, close this screen and click on the Seal/Sig. Use the location button again to move it to

the page. However, the seal size must be changed in the Word document.

Recreating a Seal and Signature

There may be instances where the Certificate Seal has already been created but needs to be replaced.
In the Sealing Clause tab, click Remove Seal/Sig, then follow the instructions above to add an Electronic
Seal.

Disable the Seal and Signature

The below instructions can be applied to stop the seal and signature from printing on a certificate. There
is no need to delete any saved seals/signatures; disable this tick box so it no longer prints on the
certificate. 

1. Search or select Certificates.

2. From the Sealing Clause tab.

3. Untick the Print Seal and Signature tick box. 

4. If this is to be applied as the default for the selected certificate type, click Set as Default.



Report Settings Tab
The Report Settings tab has settings which allow other reports to print when a certificate is produced. 

Some state acts and building combinations allow the applicant's details to be printed on the certificate.
For those that don’t, a cover letter can be created and added to the certificates. 



Use Text instead of Com. Prop. register (This option must be selected each time a certificate is
produced) 
When printing a certificate, the Common Property Register is automatically printed along with the
certificate. You may type common property information directly onto a text file for a certificate, or set
this information up in the Common Property Register. This is much quicker and easier if all lots have the
same information.

By default, StrataMax will print the Common Property Register report. 

Common Property Annexure Always  
Tick to print the Common Property Register. Please see this article on managing the Common Property
Register for more information.

Print Cover Letter (This option must be selected each time a certificate is produced) 
Tick to print a cover letter after it is setup. Click Edit Cover Letter button if you need to edit the letter
instructions below on how to create a Cover Letter.

Print Cover Letter with each Certificate (This option must be selected each time a certificate is
produced) 
Set to print a cover letter with each certificate. StrataMax will generate a code which can be used for
applicants to purchase subsequent Certificates online. Refer to On-Line Certificates for full details.

Edit before print 
Opens the 'Report Data Editor' window after clicking the Proceed button, where certain fields can be
edited to appear on the certificate. This may not work for all templates selected. Note also that this
function is progressively being phased out of this screen as new functionality is being introduced.

New Owner Form 
If set, a Roll Details New Owner form will print with the certificate. 
Right click on the New Owner Form words to open the template selection screen to select the New
Owner Form template.  There are only two templates to choose from. 

Calculate Current Interest 
Interest is calculated daily but does not post on the lot account until a payment is made, or the month
end rollover is conducted. This option will add any accrued interest to the payable amount.

Print Contracts Register 'Always' button 
Click on the 'Always' button to always print contracts.

Print Financial Statements 
Select from one of the options to print a Financial Statement for the Current Year, the Old Year or None.

Print Cover Letter always and Print Cover Letter for each Certificate always  
These two tick boxes are default settings. If set, this will keep Print Cover Letter always and Print Cover
Letter for each Certificate always on.

Creating a Cover Letter
The certificate cover letter uses a cover letter template as a base template and then text can be added
to appear within this template. Merge fields may be used to merge the data on to the cover letter. 

https://smhelp.stratamax.com/help/common-property-register#common-property---add


Selecting a Cover Letter Template  
A cover letter template only needs to be selected as required. If changes are required for the text, use
the instructions below to edit the text in a Cover Letter. 

1. Search or select Certificates. 

2. First select the cover letter template in the Settings tab. 

3. Click the button next to the 'Cover Letter' to view the templates. 

4. Highlight the template and click Preview to preview the template, or Select as Global to set the

selected template. 

5. Click Close to close out of the selection screen.

Editing the Text in a Cover Letter
1. Search or select Certificates.

2. In the Report Settings tab, click Edit Cover Letter.

3. Select Global if creating a cover letter that will apply to the certificates in all buildings, or This

Building for this building only.

4. Edit the text in Notepad.

5. Save the text file or close and click Save on the exit prompt.

Edit the Text in a Cover Letter - PEXA & Online Payments
The cover letter can be edited to include the StrataPay Reference Number for the associated Lot
Account so that the details can be used to make payments using the individual unique StrataPay
Reference Number and the StrataPay Biller Code or BSB - this transaction will reconcile automatically
through the Bank Rec.

The BSB number and Biller Code are hard coded on the Levy Notice Deposit Slip and can be typed into
the cover letter following the below steps. 

1. Search or select Certificates.

2. Click the Report Setting tab. 

3. Click Edit Cover Letter. 

4. Select Global or Local as required. Global will report across your portfolio. 

5. Enter text for the cover letter including the BSB/Biller Code and StrataPay Reference special text

<StrataPayRef>:



6. Click File > Save.

7. Produce a sample Certificate for a Lot A/c to ensure the cover letter has been set as required. 

The property Bank Account Number should not be supplied for payments as the transaction will
require manual allocation in the Bank Rec.

Setting the Defaults for the Cover Letter
1. To set the cover letter as the default every time.

2. In the Report Settings tab, at the bottom on the screen is the default settings, check or uncheck the

Print Cover Letter Always and Print Cover Letter with each Certificate option. 

If this is ticked the two options above it (next to Edit Cover Letter button) will automatically be

ticked.

If this is unticked, the two options above will not be ticked.

Document Inclusion
Document Inclusion allows documents to be added to a list so when a certificate is produced, these
documents are automatically printed as an addition to the certificate. Documents can be add locally (for
this specific building) or globally (for this certificate for all buildings).

It's important to note that the documents added to Document Inclusion will not be available via Online
Certificates.

Lots with Utility Subgroup

If the subject lot is in a Body Corporate, which is bulk-billed for electricity. Individual meters for each
lot are read periodically and bills are sent by the Body Corporate manager either to the owner or the
tenant. In any event liability for unpaid electricity charges rests with the owner.

If bills are sent to the owner, the attached certificate will include amounts owing up to the last meter
reading. For settlement, allowance must be made for any amount owing pursuant to a final reading.

The new owner will be responsible for any unpaid electricity charges. It is therefore recommended
that a sum be withheld at settlement.



Adding the Document to the Document Inclusion List

1. In Certificates, click Document Inclusion.

2. Highlight the Certificate that the document will be added to, then click Add Document, either locally

or globally. 

3. This will open the DocMax 'Add Document' screen.

4. If the document is already in DocMax, navigate to it and click Select Document.

5. If the document is not in DocMax, you can either navigate to it using the Add New Folder Location

option (in the list to the left), or save the document to the Windows Desktop and locating it using

the Desktop folder, then click Select Document.

6. Once added, select the document type using the drop down list, either General, Electricity/Utilities

Letter or Unliquidated Claims.

7. Use the navigation buttons to view, remove or move the order of the document.

8. Repeat if more documents need to be added.

9. Close by click the X at the top of the Document Inclusion window.

Deleting the Document from the Document Inclusion List

1. In Certificates, click Document Inclusion.

2. Highlight the document to be deleted by clicking on the Title.

3. Click the red X and then click Yes to confirm deleting the attachment.

Printing a Certificate
StrataMax will automatically select the certificate which is appropriate for this building/state. There is
additional information in this article for Queensland Disclosure Statements. 

http://smhelp.stratamax.com/help/docmax-add-documents
http://smhelp.stratamax.com/help/qld-certificates


Before printing a certificate, ensure the following:

Office Bearers and Insurance information is up to date.

All receipts for the subject lot have been posted. 

Utility Groups: There is a a function that will allow any Utility setup to be added to the Certificate

from the Document Inclusion list. The note can also be added on the cover letter.

1. Search or select Certificates.

2. Tag the lot in the Lots tab.

3. Select the applicant in the Applicants tab. Using either the Select Applicant to pick a non-owner

contact or Select Owner as Applicant to pre-fill from the lot selected's contact information.

4. If this is not set for default and is required, type in the fee in the 'Application Fee' field. Select

whether the fee has been or has not been paid, which will be output on the cover page if included.

5. In the Report Settings tab, select the additional reports to include, for example, the Contracts

Register. Once selected, click Always to set it as the Default. For infrequent requests that do not

require these reports to be included, untick the reports before producing the Disclosure Statement.

6. Review the 'Print Seal and Signature' box in the Sealing Clause tab to include or exclude any saved

Seal and Signatures.

7. Set any other disclosure statement or general report settings you require using Info Editor or

Document Inclusion.

8. Click Proceed.

A copy of the Certificate will be available in DocMax and on the Roll as an attachment.

Edit By-Laws Text
These are the required steps to edit the By-Law text.

1. In Certificates, click Options > Custom Text.

2. Click the By Laws Text button.

3. Notepad will open, where you can enter any required text before saving and closing Notepad.

4. Review the 'By-Laws' section in the certificate via a on-screen preview before printing/sending.

https://smhelp.stratamax.com/help/certificates-main#applicants-tab
http://smhelp.stratamax.com/help/docmax-documents
https://smhelp.stratamax.com/help/roll-configuration-overview#view-document-attachment


Edit Before Printing
Certificate details can be edited prior to previewing and printing the certificate or disclosure statement.
The information changed here will not be updated in any part of StrataMax. This process should only be
used for minor changes when there is a need for the certificate to be printed before any changes to the
building are made. See the individual articles for each state under the Certificates category for
information on the fields within the 'Report Data Editor' window.

1. Proceed to print a certificate as per the instructions above, then in the Report Settings tab tick Edit

before Print.

2. Click Proceed.

3. This will present the 'Report Data Editor' window with a list of fields that can be edited. 

4. To edit a field, select the field then click the Edit button.

5. Make changes to the text in this field, then click on OK.

6. When finished changing the information, click Close to continue producing the certificate.

https://smhelp.stratamax.com/help/certificates


Certificates (Sub-Group)
For Certificates in buildings that have a utility group, a message can be included such as 'Electricity
Supply Charges are Billed Separately', and you should check whether any unpaid amounts apply to this
property. The note could be on the cover letter which can be accessed via Certificates.

Alternatively, in Certificates in Main > Options > Custom Text > Field 2360, type in the message relating
to Utility billing e.g Please Note, this building has sub- metered Utility Billing, please contact this office.
This note will appear under the 'Additional Information' section on the certificate.

If the Sub-Group account is linked to the Main account via data links, and in Certificates > Special, the
option utility notice always is ticked, then the amount of the due but unpaid utility charges for that lot will
be reported under the 'Other Amount Due' field, on the Certificate.

Based on the Sub-Group financials, if using Trading Fund Setup with additional funds the certificate may
need to be edited before printing to update any standard fund balances. For example, Last Year Sinking
Fund Balance will report the balance of the Sinking Fund for the QLD Disclosure Statement.  

The Secretary information may also need to be annually populated via Edit Secretary Address within the
Special file menu. This is due to Office Bearers not existing at the Sub-Group level. When selected, enter
the Secretary Name and address information.

http://smhelp.stratamax.com/help/certificates-main
https://smhelp.stratamax.com/help/trading-fund-setup
https://smhelp.stratamax.com/help/certificates-main#edit-before-printing



